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From Jim Mclintosh, Senior Country Officer, jim.mcintosh@bsbi.org

Atlas 2020 Data Entry & Validation

Dear Vice County Recorders. | hope you are making good progress entering your data and are on track
to complete and upload all records to the DDb before the 31 December deadline. Please ask all your
regular contributors to submit any outstanding records as soon as possible to give you time to process
their records. If it looks like you are definitely not going to meet the deadline, for whatever reason,
please get in touch. But please do try your very best to meet the deadline — the sooner we have a fixed
data set to work with, the sooner we can move on with the process of checking records nationally.

If you are up to date with data entry, thank you! After drawing breath, checking the priority records
flagged up in your ‘my county’ page is the next step. There is guidance on validation and editing on
the Atlas 2020 page, but please do get in touch if you have any questions. The deadline for checking
your county records is April 2020, but | and others will be involved with the process for much of the
year, and will almost certainly be contacting you about the odd record or two from time to time, so
there is no escaping me any time soon!

Pete Stroh, BSBI England Officer

Atlas 2020 taxonomy

A few people have asked recently about Atlas 2020 and the new edition of Stace (Edition 4). So, a
quick reminder that we will continue to follow Stace 3 taxonomy for all data entry / submission to
Atlas 2020 before the deadline. However, we will use Stace 4 taxonomy in all Atlas 2020 outputs.

We welcome interesting records of new aliens but, because the list of taxa to be included in the Atlas
has, largely, been finalised, it's not critical to send in these one-off records before the deadline.

Generally only taxa already in MapMate will be mapped. One important exception to this is the known
Zostera issue. We will imminently issue a patch to address this that will enable all previously entered
records to display properly and allow new records to be entered and included in a final synch.

Kevin Walker, BSBI Head of Science

Taxa not in MapMate

Following on from the above, I've had a few queries from Recorders about how to record taxa that
don’t appear to be in their MapMate (even though they are in other copies of MapMate).

Helpfully you can see a complete list of all taxa that you ought to be able to record in MapMate by
looking at the MapMate Taxon Id list in the BSBI Distribution Database. To do that click Tools >
Checklists > and scroll down to find MapMate Taxon Id under the “Identifier” heading. Or jump straight
there by CTRL + clicking the link. Then click the /tems tab, and click the Taxon header to sort
alphabetically.
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So, you ought to be able to enter all the taxa listed here in your MapMate (well apart from some
Zostera taxa — see above). If you can’t then try following these three steps:
1. Check you are completely up to date with all vascular plant patches by logging onto the
MapMate User Zone.
2. Check you have selected “Vascular plants (microspecies) and charophytes” as your recording
species group in MapMate (in the View > My Configuration procedure)
3. Finally, in MapMate, View > Species Checklist, right click on Plantae (kingdom: plants) and
“Find...”. Enter the missing species name and OK it. Assuming it is found in the tree right click
and “Add”. You should then be able to enter the record.

If after all that you still can’t enter records of taxa in MapMate that are in the DDb Checklist, send
them in a spreadsheet to Tom Humphrey who will upload them directly to the DDb. But remember
there is no urgency to add one-off or very rarely recorded aliens (and genus records) — whether they
are already in MapMate or not.

Jim MclIntosh, BSBI Scottish Officer

Windows 7

Microsoft will no longer support Windows 7 after 14 January 2020 and | would recommend that all
Windows 7 users upgrade to Windows 10. Although Windows 7 won't suddenly stop working, the lack
of continued support from Microsoft would put people at increased risk from viruses and other
malicious activity. What's more, if a large number of people continue to use Windows 7, this might
encourage even more malicious users to target viruses and other nasties at Windows 7. Also, a large
number of people are now running MapMate on Windows 10 quite happily.

Although the upgrade is cheap and the upgrade process straightforward, if your machine is old, then
it might be better to buy a completely new Windows 10 PC. There is helpful guidance on upgrading
and whether to upgrade or buy new on the Techradar website. If necessary, you can start dropping
hints that a new PC would be a great Christmas present now!

Of course, before any Windows 10 upgrade, you should ensure that you have a complete, separate
up-to-date backup of all your files, ensure that MapMate records have been fully sync'ed and also that
a MapMate backup has been saved separately or stored on MapMate's server.

Tom Humphrey, BSBI Database Officer

Moving MapMate to a new PC

Co-incidentally, I've prepared straightforward guidance on how to move Mapmate to a new PC in
response to four requests for advice on this in as many weeks. It’s available on the BSBI MapMate
Support website. Of course, once you have moved MapMate to a new machine — you should not use
it on your old machine as that will really confuse the MapMate system.

Jim MclIntosh, BSBI Scottish Officer
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Hectad and tetrad recording from 2020

BSBI’s longstanding recording guidelines state that records should be at 2km (tetrad) precision or
better and should be dated precisely. Following a decision by Recording & Research Committee, from
2020 BSBI will no longer accept new records at worse than tetrad precision. The change won’t affect
existing occurrences in the DDb and we’ll continue to add old data recorded prior to 2020 at any
resolution. From now on we will no longer accept post-2019 records that have been given a date-span
greater than one year.

We are still reviewing whether we should continue to accept tetrad data. Following last month’s article
proposing that the BSBI only accept monad or better records in the next recording period beginning
in 2020, | had several positive comments and only one note of concern. The County Recorder, who is
currently aiming for 100% coverage of his VC at tetrad or better, was worried that turning away casual
records at lower resolution would result in a loss of data and turn-off casual recorders. | argued that,
in general, most records from third parties are already at monad resolution or better and that no one,
except some of his regular contributors, use tetrads because they are so hard to understand. So
obviously it would be important to explain the change in policy to all contributors (both regular and
irregular) including local group and BSBI members. And if any records at tetrad resolution are
received, then County Recorders should ask for finer grid references.

Jim MclIntosh, BSBI Scottish Officer

Vice-County Annual Reports for 2019

Recently at New Year we have asked for annual reports for all VCs which we publish on the BSBI
country pages of the BSBI website and in the country newsletters. There is much to report in this final
year of Atlas 2020, when recorders and members have been particularly busy and I’'m sure members
will enjoy reading about those achievements. Although the report is very short — less than 250 words
— we don’t want to add to Recorders’ workload at this crucial point for Atlas 2020, so we will delay
calling for the 2019 Annual Reports until February. Guidance on the format, content and number of
words will be published in the February issue of BSBI eNews and we will set up Survey Monkey to
automatically collate and collate responses - which is no mean task with 153 Vice-Counties. Every
year a few very enthusiastic recorders submit their reports early —and it is great that they are so keen
— but I'd be really pleased if they could hold back and only submit reports when called to do so by a
direct email in early February!

Jim MclIntosh, BSBI Scottish Officer

2020 Field Meetings & 2019 Field Meeting Reports — final call

Thank you to everyone who has volunteered a 2020 field meeting. They are really appreciated by
members. There is still time to add further meetings to the 2020 programme but you’ll have to be
really quick as Yearbook print deadline is early December. Send details to me copying your Country
Field Meeting Secretary in.

And thank you to all those who organised field meetings in 2019. If you haven’t already submitted
your field meeting report, again you’ll have to be quick because of that imminent Yearbook deadline.
Please send me your reports directly (and not to Trevor James who is unwell).

Jonathan Shanklin, Hon. Field Meetings Secretary
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BSBI England Committee

Council and Trustees have agreed to the formation of an England Committee and this was formally
announced at a Special General Meeting held during the BSBI AGM (see below) at the Natural History
Museum. The Committee will look after botanical issues in England, the Channel Islands and the Isle
of Man. Mary Dean has agreed to become its England Field Meetings Secretary. There will be further
details in the January issue of BSBI News and on the BSBI website in due course.

Jonathan Shanklin, Chair, Committee for England

Scottish Botanists’ Conference

We had a record attendance of 200 for an exciting day of botanical talks, workshops, exhibits, posters,
the BSBI Scottish AGM and meeting up with fellow botanists at the Royal Botanic Garden Edinburgh
(RBGE) on 2" November. It was particularly pleasing to see so many students and young people. We
got great feedback from participants about the new layout, which allowed much more space for the
exhibition and circulation, Summerfield books and just for sitting around chatting to friends. We
organised eight concurrent mini-workshops on a variety of topics — everything from Duckweeds with
Fred Rumsey & Helena Crouch to an Introduction to the BSBI Database by Chris Metherell and
repeated them so everyone could choose two. You can see many of the talks, all the exhibition
abstracts and a virtual exhibition of many of them on the Scottish Botanists’ Conference page.

Next year the conference will be on Saturday 31% October (in a major break with tradition!) at RBGE.
Jim MclIntosh, BSBI Scottish Officer

Presidents’ Award

The 2019 Presidents’ Award, made jointly by the Presidents of BSBI and the Wild Flower Society, went
to Angus Hannah, County Recorder for VC100, for his Isle of Bute Flora, the first ever Flora for one of
the Clyde Islands. The award was presented to the author at the 2019 Scottish Botanists’ Conference.
Find out more here.

Louise Marsh, BSBI Communications Officer

Annual Exhibition Meeting

We also had record attendance at this year’s Annual Exhibition Meeting (AEM) which was held on
Saturday 23 November at the Natural History Museum, London. 237 people enjoyed 41 exhibits, six
full-length talks, nine lightning talks and two presidential addresses. Our keynote talk from Clive Stace,
about the birth and evolution of the New Flora of the British Isles, was mentioned on many feedback
forms as a real highlight of the day. Abstracts, exhibitor websites and contact details, and pdfs of all
the talks and the two presidential addresses, can all be found on the Exhibition Meeting webpage. A
virtual exhibition and articles in BSBI News and on the News & Views blog are also in the pipeline. To
see comments and images posted by delegates throughout the day, go to the BSBIExhibitionMeeting

hashtag.

Louise Marsh, BSBI Communications Officer
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BSBI Annual General Meeting

The BSBI AGM 2019 was held during the Exhibition Meeting. Chris Miles told us about some of the
society’s successes over the past year as set out in the Annual Review 2018-9 and including the recent
surge in membership (3,074 members as of 23 November 2019). Members also voted in a new Hon.
Treasurer, Susanna Reece, who then summarised the society’s financial position. They were also asked
to vote on various issues relating to the society’s governance, including a proposal to increase
membership subscription rates for the first time in five years, which was passed. See the AGM

webpage.

Louise Marsh, BSBI Communications Officer
New Year Plant Hunt

The ninth New Year Plant Hunt will run from 1t to 4™ January 2020. Details of how to take part are
here, and results will appear in real time on the interactive results map. If you are organising a group
Hunt in your area, please send us details to nyplanthunt@bsbi.org that we can share on the website.

Louise Marsh, BSBI Communications Officer

New on the BSBI website in November

e Bookings have opened for the 2020 BSBI Wales AGM and related excursions: find out more
on the Welsh AGM webpage.

e |reland Officer Sarah Pierce has started work updating and streamlining the BSBI Ireland
pages, creating new pages and archiving older material. Links to the new pages can be found
on the main Ireland page. Take a look!

e The Resources/ Guidance & links page has a revised (Feb. 2019) GB Red List.

e The Training courses webpage has been amended with links to all the university courses we
know of with some botany in the curriculum, and also to point people towards applications
for Identiplant, the online plant ID course, which open on 1% December.

e The Annual Exhibition Meeting, AGM and Scottish Botanists’ Conference pages have all been
updated and regular updates made to the Meetings and News pages.

e County pages, and contact details on the Local Botany page, have been updated for Kent,
Northumberland, Warwickshire, Anglesey, Kirkcudbrightshire, Berwickshire, Dunbartonshire,
the Clyde Islands, Banffshire, Easterness, South Ebudes and the Outer Hebrides. This follows
the appointment by Records & Research Committee of several new (joint) County Recorders,
as well as the usual uploading of new resources and changes to email addresses.

e Minutes of recent meetings of the Committees for Ireland and Wales have been uploaded to
the password-protected Governance website and the Diary has been updated.

Louise Marsh, BSBI Communications Officer

On the News & Views blog in November

We launched the November special offer on BSBI membership with a blog-post talking about our
members’ recent successes and setting out some of the ways that BSBI membership helps plant-lovers
make a difference; we celebrated 25 years of Countryside Jobs with a guest blogpost about their
photographic competition, the prize for which is a year’s free BSBI membership; we featured a guest
blogpost from Meg, a BSBI Training Grant recipient, about the training course she attended; we
reported on the 2019 Presidents’ Award, won by Angus Hannah (see above); and we featured
interviews with both our outgoing and incoming Presidents.

Louise Marsh, BSBI Communications Officer
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